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1 I n t r o d u c t i o n

Welcome to Pazzles Mighty Creative Cutter!
Congratulations on your purchase of the Pazzles Mighty Creative Cutter and on your move to a 
more powerful and creative level of scrapbooking! With the Pazzles Mighty Creative Cutter and 
software, all scrapbookers can make cuts and use techniques that once were available only from 
professional diecutters. This computer-driven blade-cut system puts production of custom cuts 
in your hands, without the added costs (often totaling hundreds of dollars) for dies.

To get the most of your cutter, we recommend you spend a few moments becoming acquainted 
with the cutter, the WinPCSIGN software, and the supplemental Creative Cutter learning aids.

Viewing the Creative Cutter Basics video

The Creative Cutter Basics video provides quick and clear instructions on installing, setting up, 
and using the Creative Cutter. Keep it in a safe place for easy reference if you need to reinstall 
your product later on.

Using this book

Keep this manual handy as you explore the possibilities with the Pazzles Mighty Creative 
Cutter. We recommend that you skim through it to get an idea of what it contains and then 
follow the recommended reading sequence on page 2.
1



Chapter 1 Introduction
Recommended reading sequence

If you’re very comfortable with Windows® software applications and basic printer 
operation, use chapter 2 to properly install and set up the Pazzles Mighty Creative Cutter. Skim 
through chapter 3 and 6. To get the most from the cutter, work through the projects in chapter 4. 
Finally, review the contents of the remaining acquaint yourself with the techniques you can 
begin incorporating into your scrapbooking projects. 

If you’re more confident in your scrapbooking skills than you are with a computer, we 
recommend you carefully read chapters 2 and 3 first. Then work through all the projects in 
chapter 4.

• Chapter 2 will guide you through proper installation and set up of the Pazzles Creative Cutter. 

• Chapter 3 provides concise instructions on starting the cutter, using the software, and making cuts. 

• Chapter 4 leads you directly through your first projects! In just a few hours, you will master the 
techniques you'll use the most often with the Pazzles Creative Cutter. 

When you are comfortable with the techniques in the early chapters of the book, begin to 
explore the scrapbooking techniques described in chapter 5 and beyond.

Sharing tips and ideas

The folks who use the Pazzles Creative Cutter are enthusiastic, knowledgeable, and love to 
share tips and ideas! To join the discussions, get tips and suggestions from other scrapbookers, 
learn about new products, and obtain free fonts and images, visit our website at 
www.pazzles.com.

Contacting customer support

Your Pazzles Mighty Creative Cutter comes with 35 days unlimited phone support from date of 
shipping (866-729-9537). Following that period, Pazzles provides one year unlimited online 
support from the Creative Cutter support team at www.pazzles.com. After those periods, 
technical support is available from 9:00 am to 3:00 pm Mountain Time Monday–Friday at a rate 
of $25.00 per hour. Before you contact the support team, please complete the following steps.

What to do before you contact the Pazzles support team

• Check your hardware. Are all cords and connectors on the cutter and your computer fully plugged 
in? Is the cutter connected to the computer?

• If the problem seems to occur with the software, turn off your computer and then restart it. Try the 
operation again.

• Read chapter 8 for troubleshooting tips.

• If the problem is with cutting, check the blade and the mat. See “Working with the blade” on 
page 13.
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Chapter 1 Introduction
• If the problem remains after completing these steps, contact Pazzles at www.pazzles.com. Include 
the following information in your e-mail:

• Your name and (if applicable) your company name

• Your TSID number

• A complete description of the problem and if appropriate, the problem file as an attachment. 
3
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2 I n s t a l l a t i o n  a n d  s e t u p

Contents of the Creative Cutter package
Before you begin to install and set up the Mighty Creative Cutter, unpack the shipping package 
and verify you have all parts and pieces.

• Pazzles Creative Cutter Instruction Manual (this book)

• Creative Cutter “The Basics” tutorial (CD)

• USB/Serial Driver CD

• Creative Cutter machine

• Purple USB cord (1)

• Black power cord (1)

• Yellow-cap blade (1) (used for most cutting.) This blade has been properly inserted into the 
Creative Cutter blade holder.

• Blade holder with blade properly inserted

• Cutting mat (1)

• WinPCSIGN 2005 software (CD) (1)

• WinPCSIGN 2005 software training (CD) (1)

• USB security key (located in the CD wallet) (1)

• Front and back trays

• Set-up card

• Sampler CD

• Red-cap blades: only for vinyl! (2)

• Tool kit
5



Chapter 2 Installation and setup
Installing the software
Follow these instructions to successfully install and configure the WinPCSIGN software.

Installing and starting the software

1When you are prompted to enter a password, type pazzmighty

2The Cutting and Design Software for your Creative Cutter software can be inserted

                         into your CD-ROM at this time.
                         The installation program should being automatically.  If it does not, open My Computer,

                         locate the CD drive, and click the program icon.  

3To install the software, click Install Letter 2005.

Setting up the cutter and installing the USB driver

Attach the cutter to the computer

1 Verify the cutter is placed on a sturdy, flat surface that can withstand the weight of the 
cutter.

2 Connect the power cord. See figure 1.

Figure 1

Insert the USB Drivers CD into the CD drive on your computer. Be sure to complete this step 
BEFORE attaching the cutter to the computer.
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Chapter 2 Installation and setup
Install the USB driver

1 If a USB/Serial device has been installed on your machine before and the drivers that are 
about to be installed are different from those installed already, the original drivers need to be 
uninstalled.

2 If you are running Windows XP or Windows XP SP 1, temporarily disconnect your PC from 
the Internet. If there is an available Internet connection, Windows XP will silently connect to 
the Windows Update website and install any suitable driver it finds for the device in preference 
to the driver manually selected. This can be done either by removing the network cable from 
your PC or by disabling your network card by going to the Control Panel\Network and Dial-
Up Connections, right-clicking on the appropriate connection, and selecting Disable from the 
menu. The connection can be re-enabled after the installation is complete. This is not necessary 
under Windows XP SP 2 if it is configured to ask before connecting to Windows Update. (If 
you are running Windows XP SP 2, you can change settings for Windows Update through 
Control Panel\System. Click the Hardware tab and click Windows Update.) 

3 Using the USB cable, connect the cutter to your computer. See figure 2.

Figure 2

4 Flip the power switch to turn on power to the cutter. 

5 When the Windows Found New Hardware wizard opens, select "No, not at this time"

 then click Next to proceed with the installation.

6 Click Install from a list or specific location (Advanced) and then click Next.

7 Select Search for the best driver in these locations and enter the file path (your CD drive) 
in the combo-box (for example, D:\USB DRIVER), or browse to it by clicking the Browse 
button. After entering the file path, click Next to proceed. If a warning message about non-
WHQL certified drivers are about to be installed appears, click Continue Anyway to continue 
with the installation.

8 The progress of the installation is displayed on your screen. When the installation is 
complete, click Finish.

9 The Windows Found New Hardware wizard appears again. Follow steps 5 through 8 to 
complete the installation process.
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Chapter 2 Installation and setup
Determine the port the USB to Serial was assigned to

Complete these steps after installing the USB to Serial converter.

1 Go to Start at the bottom-left corner of your screen and click on it.

2 Find My Computer and right-click on it. When you do, a menu opens.

3 Click Manage.

4 Click Device Manager.

5 Click Ports to view a list of ports. See figure 3.

6 From the list of ports, look for a USB Serial Port. Take note of the port number assigned to 
it. You will use that port number when setting up plotter codes in the program. If the number is 
higher than 6, you must change it. Use the “Change the port number” procedure that follows.

Figure 3

Change the port number

Use this procedure if the port number is higher than 6.

1 Double-click on the port to open the Port Properties screen.

2 Click the Port Settings tab.

3 Click the Advanced button.

4 Look for the COM Port Number window.

5 Click the arrow to display available ports. Ports that are unavailable are marked “In Use.”

6 Choose an available port with a number 1, 2, 3, 4, 5, or 6 and click OK. 

7 Use the number to set up plotter codes.
8



Chapter 2 Installation and setup
Install the USB security key (hardlock)
9
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Chapter 2 Installation and setup
2 When the Start Up window (figure 6) opens, press the ESC key on your keyboard. The 
Welcome screen opens. 

Figure 6

3 Click the left-most image on the Welcome screen to open the Sign page box.

Figure 7

4 In the Page box, type the dimensions of the size of paper you plan to cut. For now, type 12 
in the Length and Height boxes, and then click OK. The page dimensions you typed are saved 
for use in the future, and the Workspace screen opens. 

WARNING! If the Security key is not in place or the driver is not installed, the program will 
shut down.
10



Chapter 2 Installation and setup
Configuring toolbars and software settings

1 Click the View menu on the WinPCSIGN screen, and then click Toolbars. (Toolbar 
selections determine the toolbars that appear when you open WinPCSIGN.)

2 Click each of the following options to select them: Standard bar, Tools bar, Selection 
bar, Manipulation bar, Zoom bar. The toolbars you select are marked with a checkmark. 

Figure 8

3 From the View menu, click Grid to select it. Turning on Grid is helpful in placing images 
by displaying small dots at 1-inch intervals on the Page screen.

4 Click the Settings menu, and then click Grid to open the Setting box.

5 In the Setting box, click the Unit/Page tab.

6 Under Unit of measurement, click inches.

TIP: You can change the Toolbar and Grid settings at any time.
11



Chapter 2 Installation and setup
7 Click the Vectorization tab, and then click the Make Clean box to check it.

Figure 9

Unless you reinstall the software, you should not need to make further changes to the 
Vectorization settings.

Select the plotter

1 Open WinPCSIGN.

2 Click Settings, and then click Plotter Codes. When you do, the Setup Plotter box opens.

3 Click Add/Remove and then select Mighty from the list of Active Plotters. 

4 Click Accept/Save.

Select the port

In the Port box, click COM port and then select the one assigned (see “Determine the port the 
USB to Serial was assigned to” on page 8). Try a test cut. (See “Basic procedures for using the 
Mighty Creative Cutter” on page 25.) 
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Chapter 2 Installation and setup
Working with the blade
The cutter is delivered with the blade inserted properly into the bladeholder unit.

  

Characteristics of properly installed blades

Take note of how far the blade is installed in the casing—a properly-installed blade is barely 
visible. Use the blade positioning guide included with the cutter to determine the proper blade 
length.

Many factors affect the life of your blade. 

• The weight of the paper being cut.

• The composition of the paper being cut.

• The experience of the person doing the cutting. The life of your blade will improve commensurate 
with the improvements to your technique that come with practice.

Proper adjustment and correct pressure will ensure you derive maximum longevity from your 
blade.

Replacing the blade 

Blades should be replaced when any of the following conditions occur: 

• Cut quality suddenly gets worse.

• You must continue to increase pressure to get clean cuts.

• The corners and tight turns do not cut cleanly or are pushed in.
NOTE: This condition can also be caused by using too much pressure.

Use the following procedure when it is time to replace the blade. Be sure to remove the yellow 
cap from the blade before inserting.

1 Loosen the gold lock nut from the blade casing and then remove the silver bladeholder from 
the blade casing. 

Figure 10
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Chapter 2 Installation and setup
2 Insert the blade into the silver holder as far as it will go. To avoid puncturing your skin on 
the blade, push the blade with your fingernail. 

3 Screw the bladeholder into the black plunger until the blade is barely visible and can barely 
be felt. Use the blade positioning guide to adjust the blade to the correct length. Because of 
paper thickness and characteristics of individual machines, you might need to make minor 
adjustments. 

4 Use the blade positioning guide shown in figure 12  on page 15 to check the position of 
your blade. Place the blade next to the picture; the blade in the picture and your blade should 
match. Because of paper thickness and characteristics of individual machines, you might need 
to make minor adjustments

5 Tighten the gold lock nut to hold the blade in place. 

Keeping the silver bladeholder still while you tighten the gold washer can be tricky and might 
take some practice. 

6 Loosen the thumbscrew on the cutting carriage (the black box that slides on the black rail). 
Insert the blade unit into the back opening of the cutting carriage.  SEE FIGURE 11.5. 

Figure 11

7 While supporting the carriage with a finger, push in the bladeholder. When the bladeholder 
unit is inserted as far as it will go, tighten the screw.
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Chapter 2 Installation and setup
Blade positioning guide 

Figure 12
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Chapter 2 Installation and setup
Working with the cutting mat
The cutting mat helps the paper travel smoothly through the cutter. As with the blade, proper 
use and care of the cutting mat will increase the quality of your cuts and the life of the cutter. 

IMPORTANT: Using a cutting mat beyond its useful life will result in poor-quality cuts. For 
tips on using and caring for your mat, see “Caring for the cutting mat” on page 20.

Preparing and positioning the mat

NOTE: These instructions pertain to 13x15 mats, which are used for 12x12 pages. If you are 
using a 15x15 (Super) mat, refer to the instructions that came with it.

1 Cut strips from the protective sheet that covers the cutting mat. On a 13x15 mat, cut ½" 
strips on the left and right sides and ¼" strips on the front. See figure 13.

Figure 13
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Chapter 2 Installation and setup
2 Locate the pinch rollers on the cutter. The two pinch rollers hold the mat in place in the 
cutter. (See figure 14.) If they are not visible, push the carriage out of the way to find them. To 
move the carriage, turn off power to the cutter.

Figure 14

IMPORTANT: The pinch rollers must always remain in the area of the black gripper on the 
silver roller. If they are not centered on the left and right gripper, move them to the correct 
position. See figure 15.

Figure 15

3 Insert the mat into the cutter. Use the guidelines that follow.
17



Chapter 2 Installation and setup
Insert the mat into the cutter

a Center the mat equally under the pinch rollers. Line up the front edge of the mat with 
the top edge of the white ruler marks. See figure 16.

Figure 16

b Turn on the Creative Cutter Mighty. When the words On Line to appear on the LCD 
screen, press the On Line button on the control panel one time. When the X and Y 
coordinates display, the cutter is offline. See figure 17.

Figure 17

c Press the left or right arrows to move the blade holder so that it is centered over the 
right edge of the paper. See figure 18 and figure 19.

Figure 18

d When you have correctly positioned the blade holder, press the red Reset button. A 
Reset button is located on both sides of the cutter. See figure 19.
18
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Pre

TIP: Pressing the Reset button sets the cutting start point. The paper size is measured from this 
location.

Figure 19

Tips for positioning hard-to-hold materials 

When working with hard-to-hold materials such as fabric, plastic, and metal), place the pinch 
rollers on the edge of the material to hold it down during cutting. The pinch rollers track at the 
very inside edge of the material. 

Figure 20

IMPORTANT: Make sure that the pinch rollers are still over the black gripper area of the 
silver roller. See figure 15.
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Chapter 2 Installation and setup
Caring for the cutting mat

When cared for properly, the adhesive on the cutting mat has a useful life of about 50-100 
passes through the cutter. To get the best results from your mat, follow the care and usage 
guidelines.

Care and usage guidelines for cutting mats

• Cover the cutting mat with protective paper before storing it.

• Always store the cutting mat flat.

• If oil from your hands gets on the mat, try to remove it with a lint roller or masking tape. 

• Scrape bits of paper off the mat, using a scraper or an old credit card.

• If lint or dust accumulates on the mat, try to remove it by patting rolled-up packing tape over 
the mat.

• Rotate the mat as you use it. To prevent warping, alternate sides. 

• If a new mat’s tack is too strong, pat the mat with your hands or with a piece of cardstock to dull 
the tack. Tack will lessen with use.

NOTE: Humidity affects tack.

Replacing adhesive on the cutting mat

Eventually the adhesive on cutting mats must be replaced. Do not remove existing adhesive—a 
total of two layers of adhesive can be applied over the original adhesive. 

How to apply adhesive from the roll 

1 Remove bits of paper from the mat’s surface by scraping with a scraper. Pick off all lint and 
bits of paper from the mat’s adhesive.

2 Hold tab as you unroll the adhesive from left to right. (The yellow tab holds the protective 
sheet and the adhesive together.) 

Figure 21
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3 Tape the left edge of the adhesive to the table.

Figure 22

4 Apply the mat with the OLD adhesive side DOWN. Align the bottom edge of the mat to the 
bottom edge of the adhesive.

Figure 23

5 Roll and press the mat down towards the top edge of the adhesive.

Figure 24
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Chapter 2 Installation and setup
6 Cut along the right side of the mat to separate the adhesive roll from the cutting mat. Then, 
trim the left side of the mat.

Figure 25

7 Use a Lil’ Chizler or an old credit card to squeegee the new layer of adhesive to the old 
layer. 

Figure 26

8 Pop any bubbles with a needle and squeegee to flatten. 

Figure 27
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Chapter 2 Installation and setup
9 Peel the protective sheet from the adhesive, taking great care that the new adhesive layer is 
firmly bonded to the mat. 

Figure 28

How to tell when you need a new mat

• You have applied two additional layers of adhesive.

• Your mat is warped, heavily scored or won’t lie flat.

• You have a new blade and your cutting quality is poor overall.

• Your design cuts fine in some places but not in others.

IMPORTANT: Using a cutting mat beyond its useful life will result in poor-quality cuts. 

Tips for getting the most from your cutter blade and 
mat

• Do not over-extend the blade. You should barely be able to see or feel the blade.

• Use proper pressure when cutting.

• Store the mat flat and covered with protective sheet.

• Replace mat after recovering with adhesive two times.

IMPORTANT: If you see heavy score marks in the adhesive, your blade is out too far or the 
pressure is too great. 
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3 B a s i c  p r o c e d u r e s  f o r  u s i n g  
t h e  M i g h t y  C r e a t i v e  C u t t e r

Introducing the Cutting control panel
The Cutting control panel plays an important role in the success of your cutting projects. It’s 
important you are familiar with the Cutting control panel and the settings you will apply to it. 
Refer the information in this chapter as you use the cutter. See figure 29.

Figure 29
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Chapter 3 Basic procedures for using the Mighty Creative Cutter
Settings for the Cutting control panel

Material

Usually set Material to 12.00. Change the setting if you are cutting wider paper. For example, 
when cutting 15" paper, change the setting to 15.00.

Advance

Leave clear (not checked).

Vinyl size

Shows the position of the object on the page.

Zoom tools

Enables zooming in and out while within the cutting mode.

Color boxes

Enables you to select which line color to cut.

Panels

If 101, 102 appears, indicates that your project is too big for the paper.

Starting and using the cutter

CAUTION: Do not leave the cutter powered on for extended periods.

IMPORTANT: Before you begin, verify all software and hardware is installed and configured 
correctly. See chapter 2 and the previous section for details.

Step 1: Start the cutter

1 Turn on cutter by pressing the rocker switch on the left side of the machine. 
The words OnLine appear in the display window when the cutter is on.

2 Raise the pinch rollers by turning knob on the right side of the cutter.

3 Position the paper horizontally on the mat with the top of the page rotated 
90 degrees to the left. See figure 30.
26



Chapter 3 Basic procedures for using the Mighty Creative Cutter
TIP: Because the cutter cuts the top of the page on the left side of the machine, place the top of 
the paper on the left side of the mat. 

Figure 30

4 Insert the mat into the cutter. For detailed information, see “Preparing and positioning the 
mat” on page 16. 

5 Lower the pinch rollers by turning the knob on the right side of the machine towards you. 

6 Set the pressure. For detailed information, see “Changing pressure settings” on page 30. 

7 Adjust the cutting speed. For detailed information, see “Changing cutting speed settings” on 
page 31.

Step 2: Start the software

1 Open WinPCSIGN (see “Installing and starting the software” on page 6).

2 Click the left-most image on the Welcome screen to open the Sign page box.

Figure 31

3 Type the exact length and height of the paper you are cutting in the appropriate boxes and 
then click OK. 
27



Chapter 3 Basic procedures for using the Mighty Creative Cutter
4 On the WinPCSIGN menu, click Draw and then click Circle. When you do, the cursor 
changes to a plus sign.

5 In the blank page on your screen, click the cursor about one inch inside and down from the 
upper-left corner.

6 Hold down the mouse and drag the cursor to draw a circle about the size of a quarter. Your 
screen should look similar to this: 

Figure 32

Step 3: Make the cut

1 Position the paper onto the mat and load it into the cutter. For test cuts, use lightweight 
(65 lb.) cardstock. For detailed instructions on loading the paper, see “Preparing and 
positioning the mat” on page 16. 

2 On the WinPCSIGN menu, click the Cut Panel icon to open Cutting control panel 
window.

Figure 33

3 On the Cutting control panel window, clear the Advance box if it is checked.
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4 On the Cutting control panel window, click the Options button to open the Cutting 
Options window. See figure 34.

Figure 34

5 Set the Cutting Options to match those shown in figure 34.

6 Verify that the wheels are lowered and that you have positioned the blade at the right edge 
of the paper. 

7 Press the red Reset button to set the cutting start point.

8 On the Cutting control panel, click Start to initiate the cut. If cutting does not start, see 
“Select the plotter” on page 12.

9 Examine results; continue to test various pressures until the cut is satisfactory. For more 
information, see “Tips for determining proper pressure” on page 29.

Tips for determining proper pressure

The way the blade is inserted in the blade holder, various types of papers, and differences in 
humidity and blade length can all affect the pressure required for a good cut. Although the 
pressure setting is usually between 120 and 165, it can go as high as 200. Use these tips to 
determine the pressure needed for successful cutting.

• You must test for proper pressure each time you replace the blade.

• Pressure is too high if the blade deeply scores the mat or if the paper bunches up and tears. 

• Pressure is too low if the paper does not cut completely.

• If you are cutting 65 lb. paper and require pressure under 120 for a good cut, it is possible that the 
blade is out too far. Reinsert the blade so that it is barely visible and can barely be felt, and then 
increase the pressure.

• Once you determine a good pressure for 65 lb. (light cardstock) paper, use that pressure as a 
baseline for other types of papers. For example, if a pressure of 140 works well for 65 lb. (light 
cardstock) try 90-100 for text-weight paper and 185-200 for heavy-weight paper.
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• If the start and stop points do not meet, try changing the knife offset to 12 or 13.

• You will develop a “feel” for the right pressure with experience. Don’t be afraid to experiment to 
see what works best.

See “Changing settings for pressure and speed” on page 30 for information on adjusting those 
settings.

Changing settings for pressure and speed 
Refer to the sections that follow when you need to adjust cutting pressure or cutting speed.

Cutting pressure

Pressure is the force that presses the blade through the material. You must increase the pressure 
setting as the thickness and density of the material increases. Use the procedure that follows 
and see figure 35.

Changing pressure settings

1 Press the On Line button to take the machine off line. (See figure 35, 1, 2)

2 Press the Mode button one time to select the Pressure Mode (Press +100-). (3, 5)

3 Press the Plus or Minus buttons to adjust the pressure. For medium-weight cardstock, start 
with 141 and then make adjustments. (4, 5)

4 After you have selected a pressure setting, press the Pause button to return to the Off line 
screen. (2)

5 Press the On Line button put the machine online so it is ready to cut. (1)

Figure 35

1 2 3 4 5
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Cutting speed

Cutting speed affects the accuracy of the cutter. Smaller-sized projects or projects with intricate 
designs require a slower cutting speed than larger, less-intricate projects. Use the following 
chart as a guideline to cutting speed settings.

Changing cutting speed settings

1 Press the On Line button to take the cutter off line.

2 Press the Mode button until Speed displays in the window.

3 Press the Plus or Minus buttons to increase or decrease the cutting speed.

4 Press the Pause button to return to the Offline window.

5 Press the On Line button to put the machine back online so it is ready to cut. See figure 36.

Figure 36

Size of font (inches) Size of font (mm) Speed

0.5 <10 10-20

0.5-1 10-30 30

 -2 30-50 40-50

2-20 50-500 60

>20 >500 70-80
31



Chapter 3 Basic procedures for using the Mighty Creative Cutter
Changing the position of the paper and blade carriage 
You can move the mat forward or backward and you can move the blade carriage left or right to 
adjust the cutting start point. 

Moving the mat

1 Press the On Line button to take the machine off line.

2 Press the up and down arrow buttons to move the mat to the desired position.

3 Press the On Line button to return the machine to cutting mode.

Adjusting the blade carriage

1 Press the On Line button to take the machine off line.

2 Press the left and right arrow buttons to move the blade carriage to the desired position.

3 Press the red Reset button to set a new start point and return the machine to cutting mode.

Pause the cutter

Pausing the cutter is helpful when you want to check the quality of cutting. 

• To pause the cutter, press the Pause button on the cutting control panel.

• To restart the cutter, press the Pause button again.

• To adjust cutting pressure while the cutter is paused, press the + or - buttons to increase or decrease 
pressure.

Fixing problems that occur during cutting

WARNING! If you experience a problem, do not yank the paper out and do not force the 
carriage to move. If necessary, turn off the cutter to remove the paper and move the carriage. 

For more troubleshooting techniques, see “Troubleshooting guide” on page 131.

Canceling a cutting job

If something goes wrong while you are cutting, use the following procedure to cancel the 
cutting job and start again.

1 Press the red Restart button to stop the cutting job.

2 Press the On Line button take the cutter off line.

3 Use the arrow buttons to move the blade to the cutting start point.

4 Press the red Restart button to set the new start point.
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Cutter starts to cut poorly

If the cutter was working fine and then seems unable to cut through paper, try these procedures:

• Increase the pressure setting. Pressure can be set as high as 300+. See “Tips for determining proper 
pressure” on page 29.

• Try reducing the pressure. Using too much pressure can cause poor cuts, especially in tight 
corners.

• Press down several times on the silver tip of the blade holder. Do this while the blade is inserted in 
the carriage. Sometimes a minuscule piece of paper or dust can keep the mechanism from moving 
freely.

• Check for debris around the blade itself.

• Re-insert the blade. Blades occasionally move a slight bit in the blade holder, and even the tiniest 
change can affect pressure.

• Clean the mat. Scrape off any bits of paper and remove bits of lint.

• Are the cutter platforms installed? The platforms prevent the mat from drooping which will cause 
poor cutting especially at the edges of the mat.

• Replace the mat. It might be warped or have too many layers of adhesive.

• Replace the blade. It might be worn from use, it might be damaged from a paper jam or from 
cutting heavy or unusual material, or it might be defective.

• Restart the cutter.

• Restart the program.

CAUTION: Do not leave the cutter powered on for extended periods.
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4 C r e a t i v e  C u t t e r  t u t o r i a l s

The four projects in this chapter provide you an opportunity to learn all the Creative Cutter 
techniques you’ll use the most—and each project takes less than an hour to complete!

All projects assume you have already installed and set up the cutter and the cutter software. 
If not, return to chapters 2 and 3.

Tutorial 3 and Tutorial 4 use advanced skills and can be completed in any order after you are 
comfortable with the skills taught in Tutorial 1 and Tutorial 2.

Tutorial 1: Open a graphic file, add a shadow mat, and 
fill a page with multiple images 

Open the graphic file and the software program

Step 1: Insert the Images CD
1 Insert the Sample Cutting Images CD (figure 37) into your computer’s CD-ROM drive.

Figure 37
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If the window shown in figure 38 opens, click Cancel to close it.

Figure 38

Step 2: Open the WinPCSIGN program

1 Double-click the icon your desktop screen. See figure 39.

Figure 39

2 Press the ESC key on your computer keyboard when you see the Welcome screen.

3 In the next window, click the Open Existing Document image in the middle of the screen. 
See figure 40.

Figure 40
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Find and open an image

1 Locate your CD drive under My Computer. To see all locations on your computer, click the 
arrow by the Look in: My Computer box. See figure 41.

Figure 41

2 Double-click on the CD drive.

3 Double-click on the Instruction Manual folder

4 Double-click on the Sample Projects folder. See figure 42.

Figure 42

5 Select any file by clicking on it. For this project, we are using a file called Butterfly. 

Figure 43

6 Click Open.The image you selected appears on an 8x10 page.
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Change the page size and create a shadow image

Step1: Change the page size (optional)

1 Click Setting from the menu bar at the top of the screen.

2 From the Setting menu, click Page. See figure 44.

Figure 44

3 Change the page size. See figure 45. 

4 Click OK.

Figure 45
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Step 2: Create a shadow mat for the image

1 To apply changes to an image, you first must select the image. To do that, click Tools on the 
menu bar at the top of the screen, and then click Select All. See figure 46.

Figure 46

2 Small boxes surround the image to show it has been selected. Click Tools again and then 
click Outline to open the Transformation box. See figure 47.

Figure 47

3 Make the following selections in the Transformation box:

For this setting Enter this value Notes

Thickness 0.08 In most cases, widths are between 0.02 and 0.10.

Number 1 The Number setting specifies the number of 
outlines. Three is the maximum possible.

Outline Click the box to 
select it.

Unless you are outlining text, leave all other 
boxes blank. If you are outlining text, click 
Break Text.
39



Chapter 4 Creative Cutter tutorials
TIP: To change a selection, click the Undo button .

4 When you are finished making selections, click the yellow check mark at the lower-right of 
the Transformation box. As shown in figure 48, the color of the image’s outline changes to the 
color you selected.

Figure 48

Multiply the image and fill the page

Step 1: Select and position the image

Use the Select Elements tool to select both the butterfly image and its outline. 

TIP: Select Elements is the tool you will use the most. 

1 To select the image and the outline, hold down the mouse button as you drag the mouse to 
the right and down to create a box around the entire image. Drag a big box to be sure that the 
entire image can fit inside. Imagine you are throwing a net around the image to catch all the 
parts. See figure 49.

Figure 49
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2 Release the mouse button. When you do, little boxes appear around the image to show it has 
been selected, as shown in figure 50.

Figure 50

3 To move the image, move the mouse over it until the cursor changes to the Move icon, 
which looks like two crossed arrows. See figure 51.

Figure 51

4 Click the mouse button, hold it down, and drag the image to the location where you want to 
place it on the page. For this project, place it about 0.5 inch down and 0.5 inch from the left. 
Your page should resemble figure 52.

Figure 52

5 Resize the image. Using the Select Elements tool, click one of the corner boxes. Then, hold 
down the mouse button and drag it in or out to resize the image. 

Click a corner box to resize the image.
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Step 2: Multiply the image and fill the page across

1 Make sure the image is still selected (it should be surrounded by little black boxes) If it is 
not selected, click Tools and then click Select All to select it.

2 Right-click on the screen. On the menu that opens, click Multiply.

Figure 53

3 In the Number box on the Multiply selected elements window, type the number of copies 
needed to fill the page across (side-to-side).

Figure 54

4 Set spacing values or leave the settings as-is.

5 For Copy direction, click the right-pointing arrow.

6 Click OK. The images appear across the page, as shown in figure 55.
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TIP: If you make a mistake or must change the number of copies, click the Undo button .

Figure 55

Step 3: Multiply the image and fill the page down

1 Go to the Tools menu and click Select All. Small boxes surround the images on the page, 
showing that all of them are selected. (If you prefer, you can use the Select Elements tool to 
select all the images on the page. Click the tool and then use it to drag a box around all of the 
images.)

2 Right-click on the workspace and click Multiply on the menu that opens.

3 Type in the number of rows you think will be needed to fill the page.

4 Click the down arrow for Copy direction.

Figure 56
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5 Click OK to fill the page with the image, as shown in figure 57.

Figure 57

TIP: If you have too many or not enough images, click Undo  and start over.

Cut the project

Step 1: Make the cut

1 Open the Cutting control panel (see page 25) by clicking the Cutting Control Panel 
icon.

2 Make the following settings on the Cutting control panel.

Enter this setting Enter this value Notes

Speed 20-30 Start with the slowest when first 
learning. 

Panels Leave blank If you see 101, 201, your project is 
larger than 12x12.

Material Use 12.00 for all papers that 
are 12" and under.

Reflects the size of your paper.

Pressure                    Set at 1. You will actually change

                                        the pressure on the machine  

Depends on the thickness of your 
paper and the blade length. 

Advance Leave blank. If the box is checked, clear it.

Color Select boxes Click the desired line color.      Selects only the desired cutting lines
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3 Press Start to begin cutting.

• If the cut is good: Hooray!

• If you are unhappy with the cut, insert another piece of paper, adjust the pressure up or down, 
and cut again. 

Pressure adjustments

• If the blade cuts all the way through but the stop and start points do not meet OR the paper is 
bunched up in the corners, the pressure is too high. Decrease it.

• If the blade does not cut through the paper, increase the pressure.

IMPORTANT: Do not be afraid to raise the pressure. 
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Cut the shadow mat

Step 1: Cut the shadow mat pieces

1 Put another piece of paper on the cutting mat for the shadow mats.

2 Insert the mat with paper into the cutter. See “Cut the project” on page 44.

3 Open the Cutting control panel by clicking the Cutting Control panel icon. 

4 On the Cutting control panel, click the red box to select Shadow/Outlines. 

5 For Speed, click Slowest.

6 For Pressure, if you are using the same weight paper, keep the pressure the same as the 
previous cut.

7 Click Start.

Step 2: Separate the shadow mat from the image (optional)

1 Click the Select Elements tool.

2 Right-click on the workspace and click Color Selection from the menu.

TIP: Turn Color Selection off by de-selecting it in this menu.

3 Click directly on the outline. When you do, everything in that color is selected.

4 Move the arrow over the image until the arrow changes to a cross (the Move tool).

5 Click and hold down the mouse button as you drag the outline away from the image.

Congratulations: you’re done!

WARNING! Do not save your projects INSIDE the WinPCSign program in the Images folder. 
Instead, create a folder in My Documents and save your projects there. If you save your projects 
in the WinPCSign program and need to uninstall, you will lose all of your projects.
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Tutorial 2: Create a title with connected letters, add a 
graphic, and create a shadow

Create your title

Step 1: Prepare the software

1 Open WinPCSIGN. See “Step 2: Open the WinPCSIGN program” on page 36.

2 Click the Create New Document image. See figure 58. 

Figure 58

3 Set up to cut a 12x12 paper.

Figure 59

TIP: These measurements will be saved in the Recent pages window so that next time you can 
easily select this size.
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4 Your workspace should look like this:

Figure 60

5 Verify you have the most-used toolbars selected. To check, click the View menu, and then 
click Toolbars. Select Standard, Tools, Manipulation, Selection and Zoom.

Step 2: Type the title

1 To type a word, first click on the Text tool .

2 The rectangle on the workspace represents the paper. Click within the rectangle to select a 
location, and begin typing the word. A black line appears where you clicked on the page.

Figure 61
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3 Type the word Summer.

Figure 62

4 Click the Select Elements tool.  It appears as a black arrow on the screen.

TIP: You will use the Select Elements tool often to select objects and to move them.

5 Click the word with the Select Elements tool. Small black squares appear around the word 
to indicate that it is selected:

Figure 63

TIP: When you click on a typed word, the whole word is selected, not just the letter you 
clicked on.

6 Choose a different font. Start by clicking the Font icon. 

7 Click the Cutting button and scroll through the font 
choices until you find Brush Script or Brush Script 
Bold. Click one of those choices.

8 Type 2 in the Height box and then click OK.

Figure 64

TIP: Click the TrueType button to see all the fonts you have installed on your computer!
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Step 3: Connect the letters
1 To make it easier to see your work, zoom in on the word. To 
do that, find the Zoom toolbar and click the Zoom Selected 
icon. See figure 65.

Figure 65

TIP: Make sure your word is still selected. 
Click on the word with the Select Elements tool. 

2 Click Text in the menu bar at the top of the screen.

Figure 66

3 From the Text menu, click 
Visual Text Spacing. 

Figure 67

Note that there 
is an arrow 
pointing to the 
right. There 
are also small 
boxes below 
each letter.

Figure 68
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4 Click the arrow 
pointing to the right. 
Then, hold down the 
mouse button and 
drag the arrow to the 
left. Watch how the 
little boxes move as 
you drag the arrow.

Figure 69

5
Release the mouse button and 
watch as the letters move to the 
location represented by the 
little boxes. See figure 70.

Figure 70

6 To weld the letters into 
one complete word, the 
letters must overlap as 
shown in figure 71. 
Continue to adjust your 
word by moving the arrow 
left or right until your word 
looks like the one shown.

Figure 71

TIP: You can adjust individual letters by selecting the box below a letter and moving it with 
your mouse.

7 Click the Select Elements tool  and then click the word to select it.
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8 Click on Tools and select Welding. 
The overlapping letters weld together.

Figure 72

Figure 73

Congratulations! You just made your first title!
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Cut your title

Step 1: Select the inside and outside part of the word

TIP: Before typed text is welded, you can select it by clicking anywhere on the word. All parts 
inside and out will be grouped together with one click. After you weld the word, the inside and 
outside parts are separate and you must select both the inside and outside parts. Be sure to select 
all the parts. If you don’t, you will leave pieces behind when you move the word.

1 To select both the inside and outside parts 
of your word, click on the Select Elements tool. 

2 Click a spot on the workspace that is above and to the left of the word. Hold down the 
mouse button as you drag the mouse to the right and down to create a box around the entire 
word. 

TIP: Drag a BIG box! You must drag a box big enough to fit the entire word inside. Otherwise 
you may not get all the parts.

Figure 74

3 Position the word: 
To move: Move the mouse over 
the word until the arrow 
changes into a cross symbol. 

Place the word approximately 
1" down from the top and 1" in 
from the left side of he page. 
Click the mouse button, hold 
button down, and drag the word 
to the proper location on the 
page.

Figure 75

Release the mouse button and little 
boxes will appear around the word to 
indicate it is selected.

Tip: Think of this as throwing a net 
around the word to catch all the parts.

Click here
X

move symbol
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4 Place a 12x12 paper on the cutting mat.

5 Insert a 12x12 paper (on mat) into the Creative Cutter. 

Step 2: Make the cut

1 Open the Cutting control panel by clicking the Cutting Control Panel icon. 

2 Make the following settings on the Cutting control panel.

For this setting Enter this value Notes

Speed 20-30 Start with the slowest when 
first learning. Most projects 
will be done on slow or 
medium.

Panels Leave blank If you see 101, 201, your 
project is larger than 12x12.

Material Use 12.00 for all papers that 
are 12” and under.

Reflects the size of your 
paper.

Pressure For medium-weight card-
stock, try 185. 

Depends on the thickness of 
your paper and the blade 
length. 

To change the pressure, 
highlight the number and 
type in the new pressure.

Advance Leave blank. If the box is checked, clear 
it.
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3 Press Start to begin cutting.

• If the cut is good—Hooray!

• If you are unhappy with the cut, close the Cutting control panel window and go back to Step 3. 
Move the title to another spot on the page.

TIP: If the blade cuts all the way through but the stop and start points don’t meet OR the paper 
is bunched up in the corners, the pressure is too high. If the blade does not cut through the paper 
increase the pressure.

TIP: DO NOT BE AFRAID TO RAISE THE PRESSURE! It is perfectly acceptable to cut 
some cardstocks at 375.

Add a graphic to the title

Step 1: Prepare the software

1 Close the Cutting control panel window by clicking on the red X.

2 Do not close the Summer page. You will be adding a graphic to the word.

3 Insert the Sample Cutting Images CD into the CD-ROM drive of your computer.

Figure 76
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4 If the window shown in figure 77 opens, click Cancel to close it.

Figure 77

Step 2: Open a graphic

1 Click File at the upper-left corner of the menu bar at the top of the Win PCSIGN screen.

Figure 78

2 Click Open.

Figure 79
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3 Find your CD drive under 
MY COMPUTER.

Figure 80

TIP: Click on the arrow button by the window to see more locations on your computer.

Figure 81

4 Double-click on the CD drive.

5 Double-click the Instruction Manual CD folder.

6 Double-click the Sample Projects05 folder.

Figure 82

7 Double-click the Summer Sun05 file.

Figure 83
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The Summer Sun image then appears on its own page, as 
shown in figure 84.

Step 3: Move and edit the graphic image

1 The image should have the selection boxes (little 
black squares) around it. If it does not, click on the 
Select Elements tool.  Then drag a box around the 
sun to select it.

Figure 84

TIP: Be sure to drag a box around the entire sun to catch the inside parts and the outside parts.

2 To move the image to another page, click Edit on the menu bar at 
the top of the screen, and then click Copy.

Figure 85

3 Minimize the Summer Sun page by clicking the 
Minimize box in the upper-right corner of the screen.

Figure 86

TIP: Two sets of boxes appear at the top of the screen. The topmost closes or minimizes 
WinPCSIGN. The bottom box closes or minimizes the page currently showing on the screen. 
See figure 87.
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4 The Summer title page should 
appear on the screen. To maximize the 
page, click the middle button.

Figure 87

Figure 88

TIP: You can see the minimized Summer Sun page in the bottom-left corner. Just double-click 
on it if you want to open it again.

5 Click the Edit menu at the top of the screen and then click Paste.

Figure 89

6 The Summer Sun image should appear at the top-right corner of the work space.

Figure 90
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7 Resize the sun if needed by clicking on a corner box. While holding the mouse button down, 
push in or pull out to resize the sun.

Figure 91

TIP: If you leave parts behind, first click UNDO  to void your last action. Then drag a 
box around the sun to grab all the parts.

Weld the title and the image

1 Move the summer sun image so that it overlaps the Summer title.

TIP: To move the image, hover the Select Elements tool over the image until it changes into 
the Move tool.

2 Select the outsides only of the sun and the title Summer. To do so, click the outline of the 
sun with the Select Elements tool. Then, while holding down the SHIFT key on your keyboard, 
click on the outside the of the title Summer. Boxes should then surround Summer and the sun, 
as shown in figure 92.

Figure 92

3 Click Tools and then click Welding to weld the title Summer and the sun together, as shown 
in figure 93.

Figure 93

Congratulations! You have just created a title with an image attached!
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Create a shadow mat for the title (optional)

Step 1: Create the shadow 

1 Select the entire title by dragging a 
box around it with the Select Elements tool.

Resize the title to your liking by clicking on one of 
the corner boxes. Hold the mouse button as you pull 
out to enlarge or push in to make smaller.

Figure 94

2 Click on the screen away from the title. This will 
de-select the title and the boxes will disappear.

3 Select the outside of the title only by using the Select Elements tool  to click on an 
outside line. This will allow you to create a shadow only for the outline.

TIP: For this project you will not create inside parts for the shadow. In future projects, if you 
would like to have the inside parts cut out on the shadow, select the entire title.

4 Go to the Tools menu at the top at the screen and then click Outline.

Figure 95

5 Make the following selections in the Transformation box (see figure 96).

For this setting Enter this value Notes

Thickness 0.08 In most cases, widths are 
between 0.02 and 0.10.

Number 1 The Number setting specified 
the number of outlines. Three 
is the maximum possible.

Be sure to select only the outside outline of 
the sun and the word summer.
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Figure 96

6 Click the yellow check mark to accept the outline.

TIP: If you need to undo something click the Undo tool at the top of screen. 

The Outline now appears in a different color around the title.

Figure 97

Step 2: Separate and position the shadow

1 Zoom the project in to make it easier to see by clicking on the Zoom Selected tool.

Figure 98

2 Click away from the title to de-select it.

3 Select the red outline by clicking on it with the Select Elements tool. 

Outline Click the box to select it. 
Then, choose the color of the 
outline by clicking on the 
rainbow color cube.

Break Text Click the box to select it. Check this box so that you 
will be able to separate the 
title (text) from the outline.

For this setting Enter this value Notes
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4 Move the mouse until you see the arrow change to a double cross that indicates Move.

5 Click mouse button and drag the outline away from the title.

Figure 99

6 Position the title where you want it on the page:

Drag a box around the entire title using the Select Elements tool.  Then move arrow over 
title until you see a double cross. Click and hold mouse button down as you move the title into 
place.

TIP: Remember that you need to drag a box around the entire title to “grab” all the inside and 
outside parts.

7 Position the shadow below the title.

8 Cut your project. For instructions, see “Cut the project” on page 44.

TIP: Cut the title and shadow twice using two different colors of paper. Then you will have two 
titles with mats.

WARNING! Do not save your projects INSIDE the WinPCSign program in the Images folder. 
Instead, create a folder in My Documents and save your projects there. If you save your projects 
in the WinPCSign program and need to uninstall, you will lose all of your projects.
63



Chapter 4 Creative Cutter tutorials
Tutorial 3: Prepare, scan, and convert a basic line graph 
to cutting format

In this tutorial, you will learn how to convert a basic line drawing into cutting format to create a 
cutting image. The line drawing can be your own creation or one found in a coloring book, 
workbook, or other resource.

NOTE: Tutorial 3 and Tutorial 4 introduce advanced skills. Be sure you are comfortable with 
the skills introduced in Tutorial 1 and Tutorial 2 before attempting the advanced tutorials. You 
can complete advanced tutorials in any order.

Prepare the line graphic
The most easily converted graphics are simple drawings with few intersecting lines.

1 Enlarge the drawings if necessary. The drawing should be at least 3"x 3". Bigger is better! 
See figure 100.

Figure 100

2 Use white out to erase parts of lines that are not wanted. Look in particular at any 
intersecting lines. Draw additional lines if desired See figure 101.

Figure 101

TIP: In some cases, it might be better to trace the drawing. Always trace if the original 
drawing has rough lines.Use the fine-point permanent marker such as a Zig pen.
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Scan the drawing into WinPCSIGN

1 Open the WinPCSIGN program.

1 Double-click the icon your desktop screen. See figure 102.

Figure 102

2 Press the ESC key on your computer keyboard when you see the Welcome screen.

3 In the next window, click the Create New Document image at the left of the screen. See 
figure 103.

Figure 103

4 In the Setup page box, type 12 in both the Length and Height boxes.These settings set up 
the cutter to cut a 12x12 paper and reflect the actual available cutting space on the paper.

TIP: Be sure you have the toolbars used most often selected. Click View and then click 
Toolbars. Then click Standard, Tools, Manipulation, and Zoom.

5 The very first time you scan, you must select the scanner. Make sure you have connected 
your scanner to the computer and that the scanner is powered on. Click File and then click 
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Select Source. You might need to power on the scanner and then close and then re-open your 
computer. Be sure to turn the scanner on before turning on the computer.

Figure 104

6 In the Select Source box, highlight your scanner and click Select. If you have more than 
one scanner, be sure to select the correct one! See figure 104.

7 To scan, click File and then click Acquire to open your scanner software.

Figure 105
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8 Scan the drawing as black and white bitmap. See figure 106.

TIP: Your scanner software might look different from the pictures.

Figure 106

9 Set the resolution (DPI) to at least 250.

10 Scan the image.
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Convert the scan into cutting format: Vectorization
Your scanned image should be visible on the WinPCSIGN workspace, as shown in figure 107. 

Figure 107

1 Verify that the image is selected. If it is, it will be surrounded by small boxes. If it is not 
selected, click the Select Elements tool and select it.

The image must be converted from pixel format (dots) to vector format (lines). This process is 
called vectorizing. Think of it as connecting the dots.

TIP: The smoother your lines are to begin with and the closer your dots are together, 
(resolution), the better the cutting image. Be sure to scan at 250-300 dpi.

Most computer graphic programs create objects with tiny dots called pixels. The number of 
pixels per inch, which is also referred to as dots per inch (dpi) is called the object’s resolution. 
The higher the resolution, the more dots per inch. And, the higher the resolution, the more 
detail in the graphic. 

To see the difference between an image created at 72 dpi and 300 dpi, look at figure 108. As 
you can see, the closer the dots are to each other (and therefore, the higher the resolution), the 
smoother the cutting lines and curves. For more information on working with graphics, 
see“Working with graphics” on page 111. 

Figure 108

300 dpi

72 dpi
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2 On the menu bar at the top of the screen, click Bitmap.

Figure 109

3 On the menu that opens, click Vectorization, and then click Automatic Vectorization. See 
figure 109. The Vectorizing tool, which looks like a magic wand, becomes available.

4 Using the Vectorizing wand, click on the image. See figure 110.

• If the Working... box appears, you have successfully vectorized the image, and you can go on to 
“Edit the image” on page 71. The Working... box provides a running tally of the percentage of 
vectorization that is complete. See figure 110.

• If the Working... box does not appear, change the resolution (see “Changing the resolution: What 
to do if you get a message about converting the image to black and white” on page 70).

Figure 110
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Changing the resolution: What to do if you get a message about 
converting the image to black and white
If you get a message stating that you must convert the image to black and white, it means that 
you did not scan in black and white bitmap. Click OK and complete the following steps.

1 Click the Bitmap menu and then click Change Resolution. The Change Resolution tool, 
which looks like a cog wheel, becomes available.

2 Using the Change Resolution tool, click on the image. When you do, the Bitmap 
resolution window opens to display information about the image. See figure 111.

Figure 111

3 Working step-by-step, bring the settings down to 1 (bits per pixel) and None (Dithering 
method). Here’s how to do it with the example shown in figure 112. 

Figure 112

1 Click 4 and None and then click OK. 

2 Click the image again with the vectorizing tool.

3 Click 1 and None and then click OK.

4 Repeat the procedure “Convert the scan into cutting format: Vectorization” on page 68.
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Edit the image

1 Delete the original bitmap. To do so, click the Select Elements tool, click on the original 
drawing, and then press the DELETE key on your keyboard. The scanned image remains on your 
screen. See figure 113.

2 Delete the box that is outside the image. Click on the box line with the Select Elements tool 
and then press DELETE on your keyboard. 

Figure 113

3 Delete unwanted lines. Select a line by clicking on it with the Select Elements tool and then 
press DELETE. See figure 114. The image on the left shows unwanted lines in red. The image on 
the right shows the image after the unwanted lines are deleted.

TIP: You can identify a line that is selected for editing because it is surrounded by black boxes.

Figure 114

4 Move the image to the upper-right portion of the workspace. 

To move the image, first select both the inside and outside of the image by clicking a spot 
above and to the left of the image. Then, hold down the mouse button as you drag the mouse 
to the right and down to create a box around the entire image. (Draw a big box to ensure you 
catch all parts of the image.)

When you release the mouse button, small boxes that indicate the image is selected should 
appear, as shown in figure 115.
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Figure 115

With the image selected, move the mouse over the image until the arrow turns into a cross 
symbol (the Move symbol). Click and hold down the mouse button as you drag the image into 
place on the page. Place it about one inch down and one inch in from the left side of the page, as 
shown in figure 116. 

Figure 116

5 Use the Move Point tool to fix small bumps and flaws like the one shown in figure 117.

Figure 117
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• Select the tool and click on the bump to grab the line. 

• Hold the mouse button down and push in or pull out to fix the flaw, as shown in figure 118.

Figure 118

TIP: Cutting images are made of lines (segments) and points. Points are where two lines meet. 
If you push or pull in the middle of a line you create an arc.  If you push or pull at a point 
you create an angle.

6 Fix bumpy, rough lines, like the one shown in figure 119 with the Line Smoothing 
(Replace Segment) tool. Click the tool above the bumpy area. Then, while holding down the 
mouse button, drag along the line to a spot below the bumps. Release the mouse button to 
replace the bumpy line with a smooth one, as shown in figure 120.

Figure 119

Figure 120

Pull out Push in
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Multiply the image, fill the page, and cut the project

1 Use the procedure “Multiply the image and fill the page” on page 40 to create multiple 
copies of the image and fill the page.

2 Place a 12x12 paper on the cutting mat.

3 Insert the 12x12 paper on mat into the Creative Cutter.

Congratulations! You’ve completed the tutorial!

WARNING! Do not save your projects INSIDE the WinPCSign program in the Images folder. 
Instead, create a folder in My Documents and save your projects there. If you save your projects 
in the WinPCSign program and need to uninstall, you will lose all of your projects.
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Tutorial 4: Hand vectorizing a graphic or photo
You can convert any drawing, graphic, or photograph to a cutting file by hand vectorization. In 
simple terms, hand vectorizing involves using some basic drawing tools to trace around the 
image. You might find that this becomes your preferred method of converting graphics!

NOTE: Tutorial 3 and Tutorial 4 introduce advanced skills. Be sure you are comfortable with 
the skills introduced in Tutorial 1 and Tutorial 2 before attempting the advanced tutorials. You 
can complete advanced tutorials in any order.

1 Open WinPCSIGN and create a blank 12x12 page. 

2 If you are importing an image, use the instructions that follow. If you are scanning an 
image, go to “Trace the graphic (hand vectorize)” on page 77. Be sure to verify your scanner is 
selected, connected to the computer, and powered on. For a review, see “Scan the drawing into 
WinPCSIGN” on page 65. 

Import an image saved on your computer

1 Click File from the WinPCSIGN menu bar.

Figure 121

2 Click Import and then click Image. See figure 121.

3 In the File Import box, find the location of our saved graphic or picture. To view small 
pictures of your image files, click the View tool and choose Thumbnails. See figure 122.

Figure 122
75

Mark Vander Woude
Text Box
You may also use this method for importing
your graphics files into your pages in WinPCSign.
This is the best way to add graphics to text,
and the easiest way to put different graphics al
on one sheet for cutting.  



Chapter 4 Creative Cutter tutorials
4 Scan the drawing as a Color Picture or Photo, at a resolution of at least 250. When you do, 
the image appears on the WinPCSIGN workspace, as shown in figure 123.

Figure 123

Resize the image to fill the screen. To do so, first click the image with the Select Elements tool. 
Click a corner handle and hold down the mouse button while you drag the picture to a larger 
size. See figure 124. 

Figure 124
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Trace the graphic (hand vectorize)

Step 1: Review the location and uses of tools

The tools described in the following table are those that are most-often used during hand 
vectorizing.

Step 2: Set the line thickness and color

1 Double click on the Segment from Path tool to open the Segment toolbar. See figure 125.

2 Click the Segment from Path tool.

3 Click the Pen and Brush tool to open its window. See figure 125.

4 Change the Pen width to 0.04 thickness and click Apply.

Tool Toolbar icon Notes

Segment from Path As you draw a segment with this tool, it will 
automatically join the segment previously 
created. To start drawing, click and drag a line. 
To continue drawing lines, click on a spot 
further away and the line will follow.

Segment toolbar Double click the Segment from Path icon to 
bring up the Segment toolbar. Use the first two 
buttons to trace around the image.

Segment tool Draws independent segments. Used most often 
for accent lines.

Move Point tool Shapes the lines to fit the picture.

Join Two Points 
tool

Joins the ends of two lines. To use, drag a small 
box around the ends.

Magnify tool Zooms in on an image so you can see detail 
better.

Show Open Paths 
tool

Locates the adjoining ends of segments that 
have not yet been connected.
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Figure 125

5 Click the Color Palette tool to open the Color window. See figure 126.

6 Right-click your mouse button on a color for the tracing line. Choose a color that will stand 
out from the picture, such as red or bright pink. 

Figure 126
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Step 3: Begin tracing the picture

1 Click the Magnify tool and use it to enlarge a section of the picture.

2 Click the Segment from Path tool. 

3 Click on a starting point and hold the mouse button down as you drag the starting line. See 
figure 127.

Figure 127

4 Continue tracing around the picture by clicking on a spot some distance away from your 
first line. As you click along the outline of the picture, a line fills in between the points. See 
figure 128.

Figure 128
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Step 4: Continue tracing and refine

1 Create smaller segments around tight areas, 
as shown in figure 129.

2 Click the Redraw tool to turn the line color to red (or whatever color you have 
chosen). 

Figure 129

3 Continue tracing around the picture until you reach the starting point. The ending and 
beginning points should connect automatically. See figure 130.

Figure 130
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4 Click the Magnify tool to enlarge a section of the picture if necessary.

5 Click the Move Point tool. You will use it to shape the lines to fit the picture See 
figure 131. 

Figure 131

6 Click on a segment that must be rounded and hold down the mouse button as you move the 
line in or out.

• To round the segment, click the middle of the segment.

• To resize the segment or create a point, click an end point of the segment.

7 Continue shaping the lines as needed all around the outline.
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Step 5: Outline other features 

1 Continue to use the Segment from Path tool to outline other features. Keep in mind that 
when using the Segment from Path tool, the end of the line must connect with the beginning 
point. 

Figure 132

2 Use the Draw Segment tool to add individual accent lines. These accent lines do not 
connect to the lines you made previously. See figure 133.

TIP: Remember to use the Redraw tool to turn the lines red, if necessary.

Figure 133
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3 Use the Move Point tool to shape the accent lines. 

• To round the segment, click the middle of the segment.

• To resize the segment or create a point, click an end point of the segment.

4 Use the Join Two Points tool to connect the ends of lines. Click and hold down the mouse 
button while dragging around the end points that need to be joined. When you release the mouse 
button, the ends should join together. See figure 134.

Figure 134
83



Chapter 4 Creative Cutter tutorials
Step 6: Check your work

1 Using the Select Elements tool, click on the image and hold down the mouse button as you 
drag a box around the new outline. When you release the mouse button, all lines within the box 
are selected.

2 From the Edit menu, click Copy and Paste to make a copy of your project. The copy will 
assist you in seeing if any adjustments must be made. See figure 135.

Figure 135

3 Make changes and adjustments as desired. 

4 Click on the graphic (photo) portion of the screen to select the photo.

IMPORTANT: Do not drag a box around everything and do not use Select All. If you do, you 
will delete the entire project.

5 Press the DELETE key on your keyboard to remove the photo. When you do, only the newly 
created cutting image remains on the screen.
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6 Click the Show Open Paths tool to find any end points that need to be connected. The 
program zooms in on all loose ends. 

• Ignore the open ends you wish to leave open.

• Fix the ends you wish to close. To do so, use the Join Two Points tool to drag a small box around 
the points to connect the ends.

Figure 136

7 Your project is done. See figure 136. Be sure to name and save it.

Congratulations! You completed the tutorial!

WARNING! Do not save your projects INSIDE the WinPCSign program in the Images folder. 
Instead, create a folder in My Documents and save your projects there. If you save your projects 
in the WinPCSign program and need to uninstall, you will lose all of your projects.
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5 M a n i p u l a t i n g  l e t t e r s  a n d  
s h a p e s

This chapter provides the information you need to add special effects to a variety of fonts and 
images. 

Tools used for manipulating letters and shapes

Tool Toolbar icon Use to...

Text tool Write text. Click the icon, click on the screen 
where you want to start typing, and then type the 
text.

Font tool Select a font and font size to apply to text. 
WinPCSIGN comes with cutting fonts, which are 
optimized for use with the Creative Cutter. You 
can also use TrueType fonts that are stored in your 
computer’s Windows Fonts folder.

Select Elements Select letters, words, objects, and parts of objects. 
To move, resize, or manipulate an object or word, 
you must first select it. 

Select the text on a page for previewing how it 
will look in other fonts. Click the text with the 
Select Elements tool, click the Text menu, and 
then click Font to open the Font preview 
window.

Erase tool Erase all or part of an image. Click on the part of 
the image you want to erase or drag a square 
around it. If you want to erase a letter or parts of a 
letter, convert the text to a path first. 
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Undo Reverse the last action completed.

Redo Reverse an undo. 

Zoom Enlarge parts of the page so you can see them 
better. Click and drag around the image while 
holding down the mouse button.

Zoom toolbar Enlarge or reduce the size of a selected object to 
help while editing it.

Change Color 
tools 

Open the color palette to change the color of an 
outline or fill. Right-click on a color to change line 
color; left-click to fill with color.

Mirror/Rotate Mirror: flip an object vertically or horizontally. 
Rotate: turn the selected element by the number of 
degrees you specify.

Move point Select a construction point on an element and then 
move it in, out, up, or down. Move Point is 
helpful in smoothing out imperfections in 
drawings. Click the center of a segment and move 
in or out to create an arc.

Break and Move Place a break in the image line and then bend or 
manipulate the line.

Cut Straight Line Cut a straight line across an object to separate it 
into two separate parts.

Join two points Join the ends of two lines together.

Cut Path Cut a line into two sections.

Tool Toolbar icon Use to...
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Changing the look of images and text
You can change the look of text and images in many different ways. The easiest is to change the 
font in which the text appears. More complex techniques include adding shadows, distorting 
text, and creating curved words and titles.

Changing and previewing various fonts

1 Using the Select Elements tool , click the text you want to change to select it. 

2 Click the Text menu and then click Font. When you do, the Font box opens with a preview 
of the selected text in the current font.

3 Click the type of font you wish to use, either True Type or Cutting. (Cutting is 
recommended), and then click a font from the displayed list of available fonts. The Preview 
boxes show the text with the new font applied.

4 When you are satisfied with your font selection, click OK to close the Font box and apply 
the new font to your text.

Measure Tools menu Measure the size of the project. From the Tools 
menu, click Measure. Then, click the project start 
point, hold down the mouse button, and drag the 
measuring line to the end point. 

Drawing tools Draw shapes. To view the drawing tools, click the 
rectangle.

Justify Position objects correctly. You can justify the 
position of objects centered to each other, on the 
page, or to the left, center, or right. Click the 
Justify tool to open the Justification toolbar, and 
then click the type of justification you wish to 
apply.

Justification 
toolbar

Tool Toolbar icon Use to...
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Moving and resizing images 

Use the Select Elements tool to manipulate a single element or multiple elements.

Selecting an object

With the Select Elements tool selected, click the item(s) you want to resize, move. or change. 
See figure 137.

• To work with a single element, click the element. 

• To work with a group of elements, drag a box around a group. See figure 137.

• To select both the inside and outside of an object, drag a box around the entire object.

Figure 137
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Resizing an object

1 Select the image with the Select Elements tool. When you do, small black boxes appear 
around the image. See figure 138.

Figure 138

2 Click one of the small black boxes to resize the image. While holding down the mouse 
button, click one of the black boxes and push it in or out. 

Moving an object

1 With an object displayed on your screen, use the Select Elements tool to select it. (If you 
prefer, you can use Select All from the Tools menu.

2 Click directly on the center of the object and hold down the mouse button. When you do, 
the pointer changes to a cross (the Move tool).

3 While continuing to hold down the mouse button, move the object on your page.

TIP: Another method of moving objects is to click the center of the object, release the mouse 
button, and use the arrow keys on your keyboard.

Filling a page with an image (multiplying) 

You can easily fill a page with multiple copies of the same image. 

1 Click the Select Elements tool and use it to drag a box around the image.

2 Right-click on the workspace and click Multiply on the menu that opens. When you do, the 
Multiply selected elements box opens. See figure 139.

3 Type in the number of rows you think will be needed to fill the page.
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4 In the Copy direction box, click the arrow for the direction you want to place the objects.

Figure 139

5 Click OK. The page fills with the image, as shown in figure 140.

Figure 140

TIP: If you have too many or not enough images, click the Undo tool  and start over.

NOTE: You can also resize the entire group of images to fit the page. Click Select All and 
move the corner box in or out to resize.
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Measuring the size of a project

1 From the Tools menu, click Measure. See figure 141.

2 Click the project’s starting point

3 While holding down the mouse button, drag the measuring line to the end point. The 
distance is displayed at the bottom of the screen.

Figure 141

Creating outlines and shadows

Figure 142

You can create an outline shadow of any letter, number, word, or shape. Use the instructions 
that follow.

1 Write a word or open an image. 

2 Select the word or image.

• To outline both outside and inside parts, select the whole image by dragging a box around it.

• To create a shadow of only the outside, click on the outside line. (For text, first convert the text 
to a path.)
93



Chapter 5 Manipulating letters and shapes
3 From the Tools menu, click Outline. When you do, the Transformation box opens.

4 In the Thickness box, type a thickness (between 0.02 and 0.15) for the outline. 

5 In the Number box, type the number of outlines you wish to apply. Do not exceed three 
outlines.

6 Click the Outline box to check it. 

7 Click the color cube to choose a color for the outline.

8 Click the Break text box to check it. This allows you to separate the text from its outline.

9 Click the yellow check mark at the lower-right of the Transformation box to save and 
apply your outline selections. To separate the outline, see “Separating the outline from the word 
or image” on page 94.

Outlining problems and solutions

If the program aborts while you are creating an outline or shadow, any of the following issues 
might be causing the problem.

• The image or word has too many outlines. Do not exceed three outlines.

• You attempted to outline a circle. Circles cannot be outlined. Use the Break and Move tool to 
create a point on a circle.

• The image or word has open paths that need to be closed. Use the Join Two Points tool to close 
the paths.

• Your outline choice is too large for the image size.

Separating the outline from the word or image

1 With an outlined word or image displayed on your screen, right-click on the image.

2 On the displayed menu, click Color Selection. 

3 Click any line in the color of the outline. When you do, all lines of that color are selected, 
and you can move them to another location on the page.
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Distorting words and images into different shapes

The Distortion tool lets you change text or objects into crazy shapes!

Figure 143

1 Write a word or open an image, and then use the Select Elements tool to select it.

2 On the Tools menu, click Distortion. When you do, the Distortion box opens.

3 Select the type of distortion:

• Select Freehand to move the image yourself. Use the arrow tool to move points or lines.You 
can select 4 or 8 points (see step 5).

• Select Use Form to choose a pre-designed image distortion available in the top window. 
Scroll up and down to see the many shapes available.

4 Select a Work option:

• Keep lines is best used for shapes composed of only straight lines. Straight lines cannot be 
manipulated.

• Convert line to curve is used to add distortion to straight lines is possible. Use Convert line to 
curve if the drawing has curves.

5 Select the number of points you wish to move, either 4 or 8.

6 Click Apply to apply your selections to the text or object.

TIP: Try the distortion tool with the images too!
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Creating curved titles and words 

Use the Fit Text to Path option on the Text menu to create text that curves under or over an 
arc.

Figure 144

1 Write a word. 

2 From the Draw menu, click Arc, Oval, or Circle. 

3 Draw the shape you want.

• To draw an arc, click Arc and then click (do not drag) at two different spots on the page. An 
arc appears between the areas where you clicked. If the arc is upside down, use the Select 
Elements tool to flip it over. Then, use the Select Elements tool to adjust the size and depth of the 
curve. 

• Be sure the arc is bigger than the word.

4 Using the Select Elements tool, drag a square around both the word and the arc. (If you 
prefer, use Select All under the Tools menu.)

5 From the Text menu, click Fit Text to Path. 

6 In the Write Text on...box, select the location on the arc where you want to write the text: 
top, bottom, left, or right. See figure 145 and figure 146.

Figure 145 Example of text curved to the top
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Figure 146 Example of text curved to right

7 Click Apply to save your selections.

TIP: To separate the line from the word, click Break text on the Write Text on... box. This 
allows you to delete the line so the word stands alone.
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Spelling words vertically 

This section provides two techniques for writing a word with its letters stacked vertically above 
the each other.

Using the Center technique to spell words vertically

Figure 147

1 Type the word letter-by-letter in the font you prefer. Press the ENTER key after typing each 
letter to move the cursor down to the next line. 

2 Use the Select Elements tool to select the word.

3 From the Text menu, click Center. When you do, the letters in the word line up underneath 
each other.
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Using the Break Text technique to spell words vertically

This technique is preferable when you have mixed upper- and lower-case letters. These letters 
often are not spaced evenly when typed vertically.

Figure 148

1 Type the word letter-by-letter in the font you prefer. Press the ENTER key after typing each 
letter to move the cursor down to the next line. 

2 Use the Select Elements tool  to select the word.

3 From the Text menu, click Break Text/Break by Character. This separates the word into 
individual letters. See column 1 in figure 148.

4 Use the Draw Rectangle tool to create a small box in the size you want to apply as spacing 
between the letters.

5 Position the rectangle between the first two letters. Select the letter to be moved and use the 
arrow keys on your computer’s keyboard to move the letter up or down. See column 2.

6 Continue using the rectangle as a spacer to help with the positioning of the letters. See 
column 3.

7 Use the Select Elements tool to select the entire word, and then drag a box around it. When 
you release the mouse button, all of the letters will be selected together.

8 From the Text menu, click Center. The letters in the word line up underneath each other. 
See column 4.

1 2 3
4
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Joining letters together

This section provides two methods for joining letters: by using the Visual Text Spacing tool 
with Welding and by using the Welding tool to weld a bar to the bottom of a word.

Using Visual Text Spacing to join letters

1 Type a word in the font of your choice and then select it. 

2 On the Text menu, click Visual Text Spacing. Visual Text Spacing places a little box 
under each letter and an arrow pointing to the right under the word. See figure 149.

3 7Move letters to overlap, using the arrow tool or the little boxes. See figure 150 on 
page 101.

TIP: If you must lengthen parts of the letters to get the proper spacing, see “How to lengthen 
letters” on page 101.

Figure 149

4 Use the Select Elements tool to select the word. 

5 On the Tools menu, click Welding. When you do, the letters should join. If the letters do 
not join, click Undo, move them slightly, and try again. See figure 150 on page 101.
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TIP: You can fix distortions after welding by using the Move Point tool. See “Tips for fixing 
welding problems” on page 103.

Figure 150

How to lengthen letters

• If you need to lengthen letters to obtain proper overlap, use the Move Point tool to lengthen them. 
For best results, weld first and then lengthen the letters. After lengthening the letters, weld the newly 
overlapped letters. 

• Create small rectangles to create a bridge between letters and weld together.

• If the letters have inside parts (such as an e or a B), be careful to select only the outside of the letter 
while welding. Click on the outside line of a letter, hold down the SHIFT key, and then click on the 
outside line of the second letter. Then, continue to weld.
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Using the Welding tool to join letters with a bar

Figure 151

1 Type a word in the font of your choice.

2 From the Draw menu, click Rectangle to draw a rectangle bar. 

3 Use the Select Elements tool to move the bar so that it overlaps word.

4 Use the Select Elements tool to select the bar and letters together. To do so, click Select All 
under the Tools menu or use the Select Elements tool to drag a box around all the elements. 

5 On the Tools menu, click Welding. 

6 Smooth out rough lines. by using the Move Point tool or by using the Replace By Segment 
tool.

TIP: If some letters distort during welding, break text by character and try to weld those letters 
last.
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Welding images and words together

Use the following procedure to weld an image and word together, as shown in figure 152.

1 Move the word and images together so that they overlap. 

2 Select both objects by dragging a box around both of them.

3 On the Tools menu, click Welding.

Figure 152

Tips for fixing welding problems

• If parts of words or objects disappear, select only the outlines of each object. To select the outline, 
click on the first object while holding down the SHIFT key, and then click on the next object.

• If objects do not weld, make sure the objects are overlapping and check for open paths. 

Using drawing tools to change letters and images
You can modify the appearance of letters and images by using WinPCSIGN drawing tools. Use 
the tips that follow.

Tips for using drawing tools

• When manipulating images, click and hold down the mouse button.

• To see the image more clearly, use the Zoom tool to enlarge it.

• If cutting or erasing a particular area is difficult, move that part of the image to the front. To do so, 
go to the Shape menu and click Order.
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Move Point tool

The Move Point tool allows you to select a construction point on an element and then to move 
it in, out, up, or down. This is very helpful when smoothing out any imperfections in your 
drawing.

Figure 153

• Using the Move Point tool, click on a point in the object and then drag it.

• Click and drag the middle of a segment to create an arc. See figure 153.

• To display all joints and points, use the Move Point tool to drag a box around the object. Viewing 
all joints and points is very helpful when making precise adjustments. See figure 154.

Figure 154

Fixing scanned images with the Move Point tool

Images that are scanned in often contain imperfections such as stray bumps. To fix this kind of 
flaw, click on the flaw with the Move Point tool and push or pull it into place.

Click on point with 
Move Point tool and 
drag to change point.

Click and drag on middle of 
a segment with Move Point 
tool to create an arc.
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Break and Move tool

Use the Break and Move tool to place a break in the image line and then bend or manipulate 
the line. To use it, place a point at a new location and then move the point to create a new look. 
See figure 155.

Figure 155

Cut Path tool

The Cut Path tool enables cutting out a segment of a line in an image. To use it, click two 
places with the Cut Path tool and then use the Erase tool to remove the cut section. See 
figure 156.

Figure 156

Alternatively, cut one spot and use the Move Point tool to move the ends to the location you 
prefer. See figure 157.

Figure 157

Create tabs to hold a project on the paper

1 Use the Cut Path tool to snip two breaks in the cutting line.

2 With the Erase tool, remove the snipped segment.
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Join Two Points tool

The Join Two Points tool is helpful for joining the ends of two lines. To use it, select the Join 
Two Points tool and then click and drag a box around the two ends that are to be joined. 

Release the mouse button to join the points.

Figure 158

Change Color Line tool

There are several reasons to change the colors of lines and fills:

• Changing colors allows you to choose cut order by color.

• Changing colors can make lines more visible.

• Changing the color of lines facilitates cutting different parts of the image at different pressures.

• Changing the color of lines helps to indicate the tools used for various lines, 

• Changing the fill color in an image helps you to visualize how the image will look when cut, and it 
facilitates printing the image on your color printer directly from WinPCSIGN. (Changing the fill color 
does not affect the way an image cuts.)

Use the following procedure to change colors in an image or letter:

1 Select the image with the Select Elements tool. 

2 Click the Change Color icon to open the Color box. See figure 159.

Figure 159
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3 Click the mouse on a color square.

• To change the line color, click the right button on your mouse.

• To change the fill color, click the left button on your mouse.

• To lighten or darken a color, move the color bars up and down.

4 To remove fill color, click the X under the B box on the Color box.

TIP:

• The B column applies fill color with a brush. 

• The P column applies outline color with a pen. 

Creating words inside a rectangle 
You can manipulate the letters in words that are enclosed in a rectangle so that they are either 
separated or attached. 

Creating a word with separated letters

1 Type a word.

2 From the Draw menu, click Rectangle.

3 Draw a rectangle under the word.

4 Weld the word and the rectangle together. See “Welding images and words together” on 
page 103.

5 Use the Move Point tool to drag the bottom-left corner of the bar over the top of the word.

6 Use the Move Point tool to drag the bottom-right corner over the top of the word. The word 
will cut from the cardstock, as shown in the final image in figure 160.
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Figure 160

Creating a word with attached letters

1 Type a word.

2 From the Draw menu, click Rectangle.

3 Draw a rectangle under the word.

4 Duplicate the rectangle (use ALT + D) and use the arrow key to move the new rectangle 
straight above the word. See figure 161.

5 Select both rectangles and the word and weld them together. See “Welding images and 
words together” on page 103.

6 Use the Eraser tool to erase unnecessary parts of the rectangles. 

7 Join the ends of the bottom and top to create sides.

8 Draw a rectangle around the completed word. 
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Figure 161
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6 W o r k i n g  w i t h  g r a p h i c s

Achieving the pages you’re dreaming of sometimes means creating, scanning, or importing 
graphics. This chapter provides background information on computer graphics and tips and 
techniques for creating graphics that cut and display well. We recommend that you complete 
the practice project to gain experience with converting graphics (see “Practice project: 
converting and vectorizing a bitmap file” on page 116).

Introduction: Pixels, resolution, vectors, oh my!
Most computer graphic programs create objects with tiny dots called pixels. The number of 
pixels per inch, which is also referred to as dots per inch (dpi) is called the object’s resolution. 
The higher the resolution, the more dots per inch. And, the higher the resolution, the more 
detail in the graphic. To see the difference between an image created at 72 dpi and 300 dpi, see 
figure 162.

Figure 162

Cutting the hundreds of dots that compose an image would be cumbersome and time-
consuming. Therefore, you must convert the image from pixels to vectors, which are lines and 
curves. This process can be done with the WinPCSIGN software, which essentially connects the 
dots for you. The closer the dots are to each other (and therefore, the higher the resolution), the 
smoother the cutting lines and curves. 

72 dpi

300 dpi
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Manipulating, scanning, and importing graphics 

Scanning a picture or drawing into WinPCSIGN

1 Draw your design, preferably in black ink that is not too fine. It is helpful to draw it large; 
you can scale it down later on.

2 Place the image on the scanner bed. It is best if you scan one image at a time. If you want 
multiples of your drawing you can create copies within the program.   

3 From the WinPCSIGN File menu, click Select Source. Your scanner model should appear 
in the pop up window. (If not, make sure your scanner is hooked up to the computer and turned 
on.) You may need to restart your computer with the scanner turned on.

4 Choose your scanner and click Select. 

5 To scan, click Acquire. Be sure that the scanner properties are set to scan your project as a 
Black and White bitmap at a resolution of 250 dpi or higher. 

6 Activate the scan. Your project should appear in WinPCSIGN. When it does, use the 
procedure “Importing and vectorizing a word or graphic” on page 112 to vectorize it.

Importing an image or word created in CorelDraw or Adobe 
Illustrator

If you have created the design in Adobe Illustrator or CorelDraw, save it as an Adobe Illustrator 
6.0 (AI) file and import into the cutting program. Be sure to convert text to lines, using vector 
as the conversion mode. You will not need to vectorize the image in WinPCSIGN. 

NOTE: This type of file sometimes results in doubled-up or duplicate lines.

Converting and vectorizing graphics
The best graphics for vectorizing are solid (filled in) and saved in black and white bitmap (bmp) 
format at 250 dpi or higher). Refer to the sections that follow to automatically vectorize images.

Importing and vectorizing a word or graphic

1 Save the image as a black and white bitmap (.bmp) file at a resolution of 250 or higher. 
Lower resolution will yield unsatisfactory results. See “Converting an image to black and white 
before saving as a bitmap” on page 116.

2 Open a blank page in WinPCSIGN. 

3 From the File menu, click Import and then select Image.

4 In the File Import box, browse to the location where the file is saved, select it, and click 
OK.

5 With the image still on the screen, open the WinPCSIGN Bitmap menu.
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6 On the Bitmap menu, click Vectorization and Automatic Vectorization. See figure 163.

Figure 163

TIP: For detailed information on vectorizing, see “Tutorial 3: Prepare, scan, and convert a 
basic line graph to cutting format” on page 64.

7 Click the image to start converting it to a vector image. Vectorizing can take a few minutes. 
When the image is converted, the new image appears in yellow next to the original.

8 Use the Select Elements tool to select the original black and white image, and then delete 
it.

9 Delete the outside square and any extra lines around the converted vector image. 

10 Use the Select Elements tool to drag a square around the converted vector image and then 
move it to the appropriate location on the page.

TIP: You might want to the change the line color to make the image more visible.

Tools and tips for cleaning up vectorized images

Depending on the quality of the original image, you may have less than perfect lines after 
vectorizing. Use the tips that follow to fix problem areas.

Replace a line

Use the Replace by a Segment tool  to replace the line. Click and drag a line over the 
problem area to replace it with a smooth line.

Replace a rough curved area

Use the Replace by an Arc tool  to replace the rough curved area. Click at the start and at 
the end of the curve. (See figure 164.) You might need to use the Move Points tool to move the 
arc into place.
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Cut away points or bad areas

Use the Cut Straight Line tool  to cut away points or bad areas. Drag the tool the separate 
the unwanted area. See figure 165.

Figure 164

Figure 165

Smooth a selected area

Use the Simply Path option from the Shape menu to smooth a selected area. Click the area 
several times to remove extra points.

Convert an uneven circle 

Use the Convert to Circle tool (double click the Oval tool) to convert an uneven circle 
to a perfectly shaped circle.

Straighten a crooked line

Use the Horizontal/Vertical tool  to straighten a crooked line horizontally or vertically.
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Eliminate stray lines

Use the Move Point and Eraser tools to eliminate stray lines. If stray lines appear in scanned 
drawings, they might be caused by stray dots in the scan, either from flaws in paper or dust on 
the scanner. The program is trying to “connect the dots” for you. Use the Move Point tool to 
drag the end of the line outside of the image and then click the Erase tool to remove them. 

Remove extra lines

To remove the extra lines, select the lines and press the DELETE key on your keyboard. If the 
lines are difficult to remove, use the Erase tool to remove two or three pieces of the unwanted 
line and then select and delete the broken sections. 

Avoid double lines

Convert the image to a solid graphic to avoid those pesky double lines. To do so, color the 
image by hand (solidly!) or use a graphics program to fill in before vectorizing.

Fixing vectorizing in scanned drawings or photographs

If you encounter problems when trying to vectorize a scanned drawing or photograph (not an 
outline or solid), convert images to an outline or solid image. To do so, first outline it by hand 
with a black pen. Then, scan at 200 dpi in black and white, or use a “paint” or graphics program 
to fill the image in and make it solid. Save the image as a black and white bitmap (bmp) file, 
vectorize, and remove any double lines after vectorizing. Alternatively, use the hand-
vectorizing method described on page 117. 

Converting low-resolution images

Some publishing programs (such as MS® Publisher, Printshop, and Printmaster) feature 
program-specific file formats. Images created in these programs often are low resolution, and 
you may not be able to save them in bitmap format. To remedy the issue, print the image in 
BEST quality, trace it, and then scan it in as a black and white bitmap. See “Manipulating, 
scanning, and importing graphics” on page 112. Alternatively, use the hand-vectoring method 
on page 117.
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Converting an image to black and white before saving as a 
bitmap 

If you receive a message during vectorizing that you are using the wrong file format or if 
nothing happens when you start to vectorize an image, the image was not saved in black and 
white bitmap (bmp) format. Use this procedure to fix the problem.

NOTE: This procedure will not work if your image is in Index format.

1 From the Bitmap menu, click Change Resolution. 

2 Click on the image. When you do, the Bitmap Resolution box opens. 

3 Working step by step, change the Bits per pixel and Dithering method selections from the 
current settings down to 1 bit per pixel and Dithering method None. Do not go directly from the 
current setting to 1 bit per pixel and Dithering none; you must proceed through each option.

4 Proceed with vectorization. See “Importing and vectorizing a word or graphic” on 
page 112.

Practice project: converting and vectorizing a bitmap file

1 From the File menu, click Import and then click Image. 

2 Locate and open Sample Bitmap 2 on the Creative Cutter CD. 

3 On the WinPCSIGN Bitmap menu, click Vectorization and Automatic Vectorization.

4 Click on your scanned image. When you do, the program begins to convert it to a vector 
image. This process can take a few minutes, especially if the image is detailed.

5 When the vectorizing process is complete, the new image appears in yellow next to the 
original. (To change the color, see “Step 1: Prepare the image and the tools” on page 117.) You 
can delete the box if you wish. 

6 Click the Select Elements tool, click on the black bitmap image, and click DELETE to 
remove it. 

7 To view the vectorized image more clearly, click the View Page tool and click on the 
screen. Then, use the Select Elements tool to drag a square around the image and move it onto 
the page, if necessary. Use the View Page tool to enlarge the page for better viewing.
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Hand-vectorizing an image
You can convert any drawing, graphic, or photograph to a cutting file by hand vectorization. In 
simple terms, hand vectorizing involves using some basic drawing tools to trace around the 
image. You might find that this becomes your preferred method of converting graphics!

For more detailed information and instructions, see “Tutorial 4: Hand vectorizing a graphic or 
photo” on page 75.

Step 1: Prepare the image and the tools

1 Scan a photo or graphic into WinPCSIGN or open a graphic that is already saved on your 
computer. See figure 166.

Figure 166

2 Resize the graphic to fill the screen. Using the Select Elements tool, click one of the 
image’s corner handles. While holding down the mouse button, drag the picture to a larger size.

3 Double click the Segment tool (located on the left side of the workspace) to open the 
Segment toolbar. You will use the first two tools on the toolbar.

Figure 167

4 Set the line thickness by clicking the Pen and Brush tool to open the Pen window. Change 
the Pen width to 0.04 or 0.05 and click Apply.

5 Set the line color by clicking the Color Palette icon to open the Color window. Right click 
on the color of your choice.
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Step 2: Trace the image

1 Use the Magnify tool to enlarge a section of the picture.

2 Click the Segment from Path tool.

3 Click on a starting point and then hold the mouse button down as you drag the starting line. 
See figure 168.

Figure 168

4 Continue tracing the image by clicking on a spot some distance away from your first line. 
As you click along the outline of the image, a line will fill in between the point.

5 Click the Redraw tool. When you do, the line colors changes to red. See figure 170.

6 Continue tracing around the picture until you reach the starting point. The beginning and 
ending points should connect automatically.
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Step 3: Shape the lines to fit the image

1 Click the Move Point tool and begin to shape the lines to fit the image. See figure 169.

Figure 169

• To round a line, click the middle of a segment.

• To resize a segment or to create a point, click on an end point of a segment.

2 Shape the lines all the way around the outline as needed.

3 Use the Segment from Path tool to outline other features. Keep in mind that when using 
the Segment from Path tool, the end of a line must connect with the beginning point. 
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4 Use the Draw Segment tool to add individual accent lines. Accent lines do not connect the 
the line made previously. See figure 170.

Figure 170

5 Use the Move Point tool to shape the accent lines.

6 Use the Join Two Points tool to connect the ends of lines. To do so, click and hold down 
the mouse button while dragging a box around the end points that need to be joined. When you 
release the mouse button, the ends should join.

7 Select the image (picture) portion of the screen and delete it. The newly created cutting 
image remains on the screen.

8 Fix any open paths. First, use the Show Open Paths tool to find unconnected end points.
Next, use the Join Two Points tool to drag a small box around the points to connect the ends. 
See figure 171.

Figure 171
120



Chapter 6 Working with graphics
Tracking customer data
Use the Customer option on the Edit menu to keep records of your customers’names, prices 
charged, and fonts and images.

Figure 172
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7 S p e c i a l i z e d  c u t t i n g  a n d  
f i n i s h i n g  t e c h n i q u e s

This chapter provides tips and techniques for specialized cutting requirements, including 
cutting on unusually sized papers, cutting on media other than paper, and applying special 
effects such as embossing during cutting. 

Tips for cutting unusual media and sizes

WARNING! When you are working with unfamiliar or heavy materials, do not leave the cutter 
unattended. If the cutter gets stuck in your absence, the motor could burn up. This type of 
mishap is not a warranted repair.

Type of 
material Notes

Vellum Be sure it is well adhered to the mat.

Mulberry paper Be sure it is well adhered to the mat. Try using mulberry cardstocks or 
sticky-back mulberry papers.

Magnetic sheets: 
thin, printable 
type

Use simple designs. Extend the blade out to its full length. Cut two 
times.

Plastic sheets Cutter can cut thin stencil plastic; some might need to be cut two or 
three times. Be sure it is well adhered to the mat.

Transparency 
plastic

Be sure it is well adhered.

Thin metal foil Use an old blade and high pressure. Extend the blade all the way out. 

Metallic papers Increase pressure. You may need to cut two or three times.

Printable canvas Make sure it is well adhered to mat.
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Special techniques for cutting

Moving objects from the front or back when working with lines

Objects are placed on the page in layers that can be rearranged for easier manipulation. Use the 
Move to Back/Move to Front tool to manipulate the image on your screen. See figure 173.

Figure 173

Sorting the inline path before cutting

Use this procedure to prevent a letter or object from popping out of the paper during cutting.

1 Use the Select Elements tool to select the object. Be sure that all parts of the object are 
selected.

2 On the Tools menu, click Sort inline path before outline.

Paper-backed 
fiber/straw papers

Might require two cuts. Cut on slowest speed.

Stiff fabrics and 
adhesive-backed 
fabrics

Make sure it is well adhered to mat.

Iron-on materials Can be ordered from www.signwarehouse.com

Vinyl banner 
material

Can be ordered from www.signwarehouse.com

Type of 
material Notes
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Troubleshooting problems with inline cutting

If a program error appears and the program shuts down while completing this procedure:

• You might have circles and ovals in the project. Create extra points with the Break and Move 
tool.

• You might have open paths. Use the Show Open Paths tool to find them. Use the Join Two 
Points tool to close them.

Cutting a project more than once

If your project uses heavy paper or other materials, you might need to cut two or three times. 
Do not lift the rollers after the first cut! 

To make cut multiple times, use one of the following methods:

Method 1: Press Copy on the cutter control panel. Be sure Advance is not checked in the 
cutting control panel.

Method 2: Press Start.

IMPORTANT: It is essential that the Advance box is NOT checked and that you do NOT lift 
the pinch rollers!

Creating stencil cuts 

You can make any font into a stencil cut. See figure 174.

Figure 174

1 Type a word and select Convert Text to Path from the Text menu.

2 Click the Cut Straight Line tool and use it to cut away sections of letters.

3 Drag and draw two lines across the section you want to remove.

4 Remove unnecessary pieces by selecting the sections and deleting them. See figure 175.
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.

Figure 175

Scoring paper 

If you want to score part of the project and cut another, as you would for an envelope, use the 
following guidelines:

• Complete the process in two separate steps. 

• Be sure to change the color of the scored part of the project. (See “Change Color Line tool” on 
page 106.)

Scoring and then cutting an image

IMPORTANT: Do not lift the pinch wheels between steps.

1 Select the color for scoring. 

2 Reduce the pressure setting to a light pressure. See figure 176.

3 Click Start. 

4 Select the color for cutting and increase the pressure.

5 Click Start.

Figure 176

TIP: You can also use the KissCut function to create scoring. See “Converting lines to stitch 
marks” on page 128.
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Cutting round corners

1 Draw a rectangle on the page.

2 Click the Round Corner tool.

3 In the Radius box, assign a value to apply to the corner and then click OK. To change this 
value later, double-click on the computer screen. See figure 177.

Figure 177

TIP: If you choose too large a radius, or a tiny segment is near the corner, you will get an error 
message.

4 Click the Round Corner tool on the corner you want to round. See figure 178.

Figure 178
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Cutting around tight corners 

To get clean cuts with fonts that have tight corners and angles, use the tips that follow.

• Use the Break and Move tool create a new break in the line.

• Use the Move Point tool to move the point away from the break. Doing so creates curves instead 
of points. The curve is imperceptible to the eye but greatly eases cutting. See figure 179 and 
figure 180.

Figure 179

Figure 180

Creating stitch marks

You can convert lines to stitch marks. Two lengths of stitch marks are available: KissCut1 and 
KissCut2. 

Converting lines to stitch marks

1 Click the Pencil tool on the left toolbar to open the Pen/Brush window. See figure 181.

2 In your image, select the line to convert.

• To apply kiss cuts to ovals and circles, use the Break and Move tool to create more points. 
Then, click on the line at four equally spaced spots.

• To apply kiss cuts to text, first apply Convert Text to Path from the Text menu to the text.
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3 In the Pen/Brush window, select KissCut1 or KissCut2 and then click Apply.

TIP: Remember to change back to a solid line before you type or draw. If you don’t, your lines 
will continue to be KissCut style.

Figure 181
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8 T r o u b l e s h o o t i n g  g u i d e

This chapter provides information on solving problems that have been encountered by some 
Creative Cutter users. Please consult this chapter before calling Support.

Troubleshooting tips 

Issue Possible causes and remedies

You want to work in WinPCSIGN 
while cutting

Open another WinPCSIGN. You can cut and paste between the two.
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How to uninstall and reinstall the 
program

Step 1: Note and record the current port settings. Click Settings and 
then click Plotter Codes.

Step 2: Remove all WinPCSIGN registry files.

If you have saved any files within the WinPCSIGN program in the 
Image folder, save them in another location before beginning this 
procedure!

1. Point to Start at the bottom-left of your computer, and click All 
Programs. 

2. Click WinPCSIGN, click Tools, and then click WinPCSIGN 
Registry. 

3. In the box that appears, select and delete all registry files. 

Step 3: Uninstall the WinPCSIGN program

1. Point to Start and then click All Programs.
2. Click WinPCSIGN, and then click Uninstall. If prompted, choose 

to delete all shared files.

Step 4: Delete the Signmax and WinPCSIGN folders.

1. Point to Start and then click My Computer. 
2. Select the C: drive and click the folder named WINDOWS. (If you 

get a message about hidden folders, select to see hidden files.)
3. In the Windows folder, click the Program Files folder to open it. 

Click and delete the Signmax folder. 

Step 5: Search and delete other files

1. Close all windows until you return to your desktop screen. Then, 
point to Start and click Search.

2. Select to search all files, type WinPCSIGN in the box, and click 
Search. 

3. Delete any files found.
4. Repeat the search process, typing Signmax in the box. The only 

folder you should see is the Signmax folder in the recycle bin.

Step 6: Reinstall the program. 

1. Use the directions in chapter 2.
2. After installing, re-check the registry files. Delete any you find.
3. Restart the computer. The registry files will rebuild.
4. In WinPCSIGN, set up the driver and port. See chapter 2.

Issue Possible causes and remedies
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The program aborts or generates a 
run-time error

Generally there are a few very common reasons for a runtime error. All 
of these are easily avoidable once you know what they are.

Issue: You are using software version Letter 14.0 and are trying to 
open files for version 2005. 

Solution: Make sure you open the cutting file folder that says 12.0 or 
14.0.

Issue: You are using software version Letter 2005 and are trying to 
open files created in an older version of the program. 

Solution: If your files are not in a folder marked _05, they are in the 
old version. You must import those files into the 2005 version. See 
instructions on our Web site at www.pazzles.com.

Issue: You are trying to Outline and you chose multiple outlines.

Solution: Three is the maximum safe number of outlines. After three, 
click on the outermost outline and do the outline function again.

Issue: You are trying to Outline and you have chosen TOO large of an 
outline.

Solution: Reduce the size of the outline.

Issue: The memory in your computer is full. The program tries to 
remember every move you make so that you can use the Un-Do 
function.

Solution: Clean the memory by going to HELP and choosing Clean 
Memory, OR go to the Setting menu and select SET UP. On the 
Document page, click Undo and change the number of saved steps to 
10 or fewer.

Issue: Errors occur when you have open paths. These are points next to 
each other that should be joined.

Solution: Use the Show Open Paths tool to find the problem. It 
appears on the bottom of the toolbar on the right side of the screen. It 
has a question mark beside a line with two dots. Then close the open 
paths with the Join two points tool. See “Break and Move tool” on 
page 105 and “Join Two Points tool” on page 106.

Issue Possible causes and remedies
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The program aborts or generates a 
run-time error

Issue: You are using the Sort Inline before Outline function. 

Solution: Check to see if you have circles or ovals made with the Draw 
tool. These objects have no beginning or end point. Apparently, this 
confuses the program! Create some points on them by using the Break 
and Move tool. See “Break and Move tool” on page 105. 

Issue: You have too many programs running in the background. They 
are all using memory to one degree or another. There is not enough 
memory to execute a function and you can get a runtime error.

Solution: Close background programs that are not necessary. 
Especially check the icons in the lower-right corner of your desktop 
screen. These tray icons mean that the program is running at least 
minimally in the background. Usually you can right click on the icon 
and bring up a menu that will allow you to shut them off. Common 
ones that seem to be default with Windows are QuickTime, AOL, 
Outlook Express, and some scanners and printers.

Start and stop points do not meet Try shortening the blade length.

Change OFFSET by opening the Cutting control and clicking the 
Options button. 

Decrease pressure.

Check the cutting mat. It might be warped or in need of cleaning. 
Remove small bits of lint from the mat.

Move the cutting start point (use the Shape menu).

Paper shoots out from under 
wheels

The cutting project is beyond allowable margins. Move the project to 
within limits or use a larger mat.

Project or page size is bigger than the paper size. 
Check the Panels box on the Cutting control panel. If you see 101, 202 
etc. your project is larger than 12x12. 

The silver rod that helps to grip and move the paper might be dirty. If 
so, use Undo SPARINGLY on a toothbrush to scrub off.

You forgot to set the start point after moving the cutting carriage.

Issue Possible causes and remedies
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Projects do not cut completely Pressure is too weak: increase it. DO NOT BE AFRAID TO 
INCREASE THE PRESSURE!

The mat is drooping due to paper weight or humidity. Place a small box 
directly behind the cutter to keep the mat flat. 

Cutting project is outside of allowable margins. Move it or check page 
settings.

There is a communication error between machine and computer. 
Restart both and check cord connections.

The paper buckles The pressure is too high. Reduce it.

The cutting speed is too high. Reduce it.

The cutting mat needs more adhesive. 

Cutting project is distorted Usually this happens only at the edge of paper at the back of the cutter. 
This kind of error means the paper is buckling or that the project is just 
outside the allowable margin. Also check to see that the mat is not 
bumping something near the cutter as it moves back and forth.

Sharp angles do not cut well Reduce the cutting speed.

Reduce the pressure. Setting the pressure too high pushes in the 
corners instead of cutting them.

Round the corner: use the Break and Move tool to change the point 
into a curve. See “Break and Move tool” on page 105 and “Cutting 
around tight corners” on page 128.

When cutting an object inside of 
another shape the shape pops out 
and gets caught on the cutting 
blade

You need to change the cutting order so that the smaller inside piece is 
cut first.

1. Select the object or project with Select Elements tool. Be sure to 
select all parts by dragging box around object or by choosing 
Select All under Tools menu.

2. On the Tools menu, click Sort Inline path before Outline under 
Tools menu.

You want to position the paper so 
that it will cut in the same place 
each time

Be sure that the box by Advance in the Cutting control panel is NOT 
checked! 

You can use a permanent marker to draw some lines to help with 
alignment. 

You’ve lost changes to a project Save, save, save! Saving a project in WinPCSIGN is as simple as 
saving in any other Windows-based program. Select Save or Save As 
under the File menu. Create an appropriate folder for your projects 
(usually in My Documents), give your project a name, and click Save. 
Save often!

Issue Possible causes and remedies
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You encounter problems while 
cutting thick materials 

When cutting thick materials such as wood, metal, and felt, you might 
need to cut two or three times to get completely through. You can set 
the machine to cut several times in the same place. Select the image 
you want to cut, being sure to select inside parts too, and right-click 
with the mouse. On the menu that appears, select Duplicate. This will 
place a copy directly on top of the original. This can be done several 
times if necessary.

You want to cut over the same 
lines because the lines did not cut 
clearly.

• Use the Duplicate function (see “You encounter problems while cutting 
thick materials” on page 136).

• Press Start again in the Cutting control panel. Do not lift the pinch 
rollers and verify that Advanced is not checked.

Vectorized drawings have stray 
lines, double lines, or just look 
like a mess

Use the procedures in “Tools and tips for cleaning up vectorized 
images” on page 113.

Issue Possible causes and remedies
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